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INTRODUCTION

INTRODUCTION

This document describes how to set up network servers and clients to use the Splash RPX-iii
Xerox 700 Digital Color Press. For general information about using the digital press, your
computer, application software, or network, see the documentation that accompanies those
products.

Terminology and conventions

This document uses the following terminology and conventions.

Term or convention Refers to

Digital press Xerox 700 Digital Color Press

Fiery Xerox EX Print Server and Integrated Fiery Color Server

Mac OS Apple Mac OS X

EFI Splash RPX-iii Splash RPX-iii Xerox 700 Digital Color Press

Titles in italics Other documents in this set

Windows Microsoft Windows 2000, Windows XP, Windows Server 2003,
Windows Vista

About this document

This document covers the following topics:

*  Setting up the network environment

* Setting preferences for the EFI Splash RPX-iii
*  Using the Web Queue Manager

* Administering the EFI Splash RPX-iii

NoTe: The EFI Splash RPX-iii server can run on Mac OS 10.5 or Mac OS 10.4. Differences
between the two operating systems are noted in instructions throughout this document.
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NETWORK SETUP

This chapter describes environments that typically include one or more network
configurations. It describes how to set up and configure your network for printing to the EFI
Splash RPX-iii from Mac OS or Windows computers.

The EFI Splash RPX-iii supports AppleTalk, Bonjour/Rendezvous, AppleShare, Microsoft
TCP/IP, Novell NetWare NDPS for TCP/IP or LPR or Port 9100 Printing, and legacy
support for NetWare Print Queue setup through PConsole.

Configuring the EFI Splash RPX-iii for AppleTalk printing

This section describes how to configure the EFI Splash RPX-iii to receive jobs from
computers on an AppleTalk network.

To CONFIGURE THE EFI SPLASH RPX-iii FOR APPLETALK PRINTING

1 Choose System Preferences from the Apple menu on the EFI Splash RPX-iii, and then choose
Network preferences.

2 For Mac 0S 10.5, click Advanced and click AppleTalk.

[&Tal & Network
edp Ethernet

——— TCP/IP DNS WINS | AppleTalk | B02.1X Proxies Ethernet -

¥ Make AppleTalk Active

AppleTalk Zone: [ US CA 303 Lab-Xerox-Mid-Rangl ] (Refresh Zones )

Configure: rAumma(icaIIv H—l

@
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Configuring the EFI Splash RPX-iii

NETWORK SETUP

Mac 0S 10.4: Choose Built-in Ethernet from the Show menu and click the AppleTalk tab.

e6o Network
[« [showall @ )
Location: [ Automatic H
Show: [ Built-in Ethernet H

1 TCP/IP  PPPoE | AppleTalk | Proxies Ethermet -

™ Make AppleTalk Active

Computer Name: SplashServer
(Can be changed in Sharing Preferences)

AppleTalk Zone: 'Vancouver LAN

Configure: rAutcmaticaIIv H

@

Apply Now )

[{n Click the lock to prevent further changes.

Assist me... (

Select the Make AppleTalk Active option.

If more than one zone is displayed, select the appropriate AppleTalk Zone.

Click Apply Now (Mac 0S 10.4) or OK (Mac 0S 10.5).

Close Network preferences.

Start the EFI Splash RPX-iii application and log on with Administrator privileges.

In the EFI Splash RPX-iii application, choose Preferences from the Splash Server menu.
The Splash Server Preferences dialog box appears.

Click the Network icon and select the AppleTalk Registration option.

For more information, see page 30.

Click OK.

for TCP/IP and LPR printing

This section describes how to configure the EFI Splash RPX-iii to receive print jobs from a
TCP/IP or LPR network.

To configure the EFI Splash RPX-iii and users’ computers for TCP/IP printing, complete
the following procedures:

* Connect the EFI Splash RPX-iii to the TCP/IP network.
* Configure the EFI Splash RPX-iii for the TCP/IP network.
* Enable TCP/IP printing.

* Configure users’ computers for TCP/IP printing.
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Connecting the EFI Splash RPX-iii to the TCP/IP network

Connect the Local Area Network (LAN) card or Ethernet port to the network.

Configuring the EFI Splash RPX-iii for the TCP/IP network

The following procedure explains how to configure the EFI Splash RPX-iii for the
TCP/IP network.

To CONFIGURE THE EFI SPLASH RPX-iii FOR THE TCP/IP NETWORK

1 Obtain a router address from your network administrator.

2 Choose System Preferences from the Apple menu on the EFI Splash RPX-iii, and then choose
Network Preferences.

3 Mac 0S 10.5: Click Advanced.

[&Tal & Network

&o2» Ethernet

—{TCP;‘IP | DNS WINS  AppleTalk 802.1X Proxies Ethernet 1

Configure IPv4: ( Using DHCP with manual address H

IPv4 Address: |10.11.96.62

Subnet Mask: 255.255.255.0

Router: 10.11.96.1

Configure IPv6: rﬁmmr'nati(ally H-‘

Router:
IPv6 Address:

Prefix Length:

@
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Mac 0S 10.4: Choose the local area network (LAN) card type or Built-in Ethernet from the
Show menu for the TCP/IP network.

8eeon Network
[« ] [showAl Q
Location: | Automatic H
Show: [ Built-in Ethernet H
—————————{-TEPHP| PPPoE | AppleTalk | Proxies | Ethernet }—
Configure IPv4: | Using DHCP +]
IP Address: 10.10.83.6
Subnet Mask: 255.255.252.0 DHCP Client ID:

(If required)
Router: 10.10.80.1

DNS Servers: {(Optional)
Search Domains: test.com (Optional)
IPv6 Address:
Configure IPv6... ®
dﬁ Click the lock to prevent further changes. ( Assist me... ) [ Apply Now J

4 To configure the TCP/IP address manually, choose Manually from the Configure menu.

Assigning the EFT Splash RPX-iii a static TCP/IP address allows users to locate the EFI
Splash RPX-iii reliably on the network. To set up the DHCP server to use the same TCP/IP
address, contact your network administrator.

Type the EFI Splash RPX-iii IP address.
NoTe: Type a Subnet mask number, if required.

Note: If the Subnet mask number is different than the default mask number, change it to
match the number used on your network. For more information, contact your network
administrator.

Type the Router address (gateway address), if required.

A network router maintains a list of IP addresses for two or more groups of network devices.
The router then uses the list of addresses to direct network data to the appropriate location on
the network. To enter two or more router addresses, press Return after typing each address.

Type the Name server address for your local DNS server on your network (Mac 0S 10.4 only,
optional).

Type the search domain name that pertains to your DNS name; for example, design.corp.com
(Mac 0S 10.4 only, optional).

Or to have a TCP/IP address automatically assigned from the network, choose Using DHCP.
5 If the Mac 0S computer is on an IPv6 network, click Configure IPv6 and proceed to step 6.

If the Mac 0S computer is not on an IPv6 network, proceed to step 7.
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6 To configure IPv6 manually, type the IPv6 address and Router address (if required), and

then click OK.

To configure IPv6 automatically, choose Automatically from the Configure IPv6 menu and
click OK.

Click Apply Now (Mac 0S 10.4) or OK (Mac 0S 10.5) to confirm the new setup.

Close the Network Control Panel.

Enabling TCP/IP printing from the EFI Splash RPX-iii

The following procedure explains how to enable TCP/IP printing from the EFI
Splash RPX-iii.

To ENABLE TCP/IP DIRECT PRINTING

1
2
3

Start the EFI Splash RPX-iii application.

Choose Login from the Server menu.

Type the Administrator password and click OK.
Choose Preferences from the Splash Server menu.
The Splash Server Preferences dialog box appears.
Click the Network icon.

Select the Enterprise Networking option and click OK.

The EFI Splash RPX-iii is ready to check that the network status for LPR/IP is online.

Configuring Windows 2000/XP/Server 2003 /Vista for TCP/IP printing

The EFI Splash RPX-iii accepts print jobs from the TCP/IP network on a Windows 2000/
XP/Server 2003/Vista or Novell NetWare NDPS LPR network. In addition, users on a
TCP/IP network can print files directly to the EFI Splash RPX-iii by using Drop folders or
Hot Folders.

NoTe: To print over the TCP/IP network, your computer must have Splash software
appropriate for your operating system installed, and must be connected to the EFI

Splash RPX-iii.

Windows computers are preconfigured with the Microsoft TCP/IP software installed. For
information about configuring Windows for TCP/IP printing to the EFI Splash RPX-iii, see
the Printing Guide.



NETWORK SETUP

Configuring the EFI Splash RPX-iii for the IPv6 network and 802.1x

The following procedure explains how to configure the EFI Splash RPX-iii for the
IPv6 network and 802.1x.

When you configure for the IPv6 network, you must configure both the Macintosh and the
Splash Server before you can configure 802.1x.

TO CONFIGURE THE MACINTOSH FOR IPv6

1

Choose System Preferences from the Apple menu on the EFI Splash RPX-iii, and then choose
Network preferences.

Mac 0S 10.5: Click Advanced.

Mac 0S 10.4: Choose Built-in Ethernet from the Show menu.

Click Configure IPv6 on the TCP/IP tab.

To configure IPv6 automatically, choose Automatically from the Configure IPv6 menu.
Click OK (Mac 0S 10.4).

To configure IPv6 manually, type the IPv6 address and the Router address (if required).
Click OK (Mac 0S 10.4).

Click Apply Now (Mac 0S 10.4) or OK (Mac 0S 10.5) to confirm the new setup.

Close the Network Control Panel.

To CONFIGURE THE EFI SPLASH RPX-iii FOR IPv6

1
2
3

Start the EFI Splash RPX-iii application.

Log on with Administrator privileges.

Choose Preferences from the Splash Server menu.
The Splash Server Preferences dialog box appears.
Click the Network icon.

Select the Use IPv6 option.

Click OK to close the Splash Server Preferences dialog box.
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To CONFIGURE 802.1x (MAc 0S 10.4)

1

2
3
4
5

Double-click Internet Connect in the Applications Folder.
Choose New 802.1X Connection from the File menu.

Choose Edit Configurations from the Configuration menu.
Choose Built-In Ethernet 1 from the Network Port menu.

Specify the other information on the pane as appropriate for your network.

To CONFIGURE 802.1x (MAc 0S 10.5)

1

Choose System Preferences from the Apple menu on the EFI Splash RPX-iii, and then choose
Network preferences.

Click Advanced.
Click 802.1X.

Specify the information on the pane as appropriate for your network.

Configuring the EFI Splash RPX-iii for NDPS Printing

The Novell NetWare server must be set up and configured prior to installing and configuring
the NetWare Client. The NetWare Client must be installed on the workstation being used to
configure the NetWare server for NDPS printing.

NoTE: Use the latest NetWare support pack and NetWare Client. For more information, see
the documentation that accompanies NetWare.

The following procedures assume NDPS has been installed on your NetWare server and is
properly configured. An NDPS Broker and NDPS Manager are required for configuring
NDPS printing. If these are not in place, contact your network administrator.

To ApD THE EFI SPLASH RPX-iii PPD 10 THE NovELL NETWARE NDPS BROKER

1
2

Log on to the NetWare file server with Administrator privileges.

Start NetWare Administrator.

NoTe: To start NetWare Administrator, go to the Sys:Public\Win32 folder on the NetWare
server and click the nwadmin32 icon.

Double-click the Broker icon in the NetWare Admin window.



1

1

Resource Management
(RMS)

Add Resources

NETWORK SETUP

4 Click Resource Management (RMS).

B NDPS Broker:broker

Idzntification

|

Identification T

Hame: |Iblokel.YES

SAP Name:  [BROKER

Access Contral j

Service Registy [SRS) j

Deseiiption: =] Event Notfication [ENS) ﬁ
d 1 fasuurcs M anagement [HMS]I

Location: I

Statu

NDPS Broker state active

Unload

Page Dptions... Help

[Cox |

Cancel |

5 Click Add Resources.

B NDPS Broker:broker x|

Rezource Management (RMS)

Identification

Access Contral

~ Resourc:

Resource Path
IYES_NWE\SYS /ndps/resdic

Add Resources ... : |

— Resource Management Service [RMS) Statu

Event Motification [ENS)

]
]
Service Registy [SRS) j
]
J

Enabled

Dizable |

Refrash
(08 I

Cancel | Page Dptions... | Help |

6 In Resource Types, select the Windows operating system that you want for the EFI

Splash RPX-iii Driver installation.

NOTE: You can add printer drivers for more than one Windows operating system, but you
must repeat this procedure and the following procedure to install the appropriate printer
driver for each Windows platform.

If the EFI Splash RPX-iii driver has already been installed, it appears in the installed printer
drivers listed in the Current Resources section. If the EFI Splash RPX-iii driver is not listed,
you must install it from the EFI Splash RPX-iii User Software and Documentation DVD.
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Insert the EFI Splash RPX-iii User Software and Documentation DVD into the CD/DVD-ROM
drive.

In the Manage Resources dialog box, click Add.
The Add Resources dialog box appears.
Click Browse in the Add Resources dialog box.

Add Resources

Resource location:

Cancel

Browse

elel

Resources to be added: s

Caution: If you add a resource that iz not of the selected
type [and platfarm). it may not function properly.

Browse to the CD/DVD-ROM drive, select the appropriate driver from the Standard drivers
folder, and then click OK.

Verify the location of the file and click OK.
Click Continue.

The printer driver is copied to the Novell NDPS Server.

Use the following procedure to create a Printer Agent for the NDPS Manager.

To CREATE A PRINTER AGENT

1
2

3

Log on to the NetWare file server with Administrator privileges.

Start NetWare Administrator.

NoTe: To start NetWare Administrator, go to the Sys:Public\Win32 folder on the
NetWare server and click the nwadmin32 icon. For more information, see the
documentation that accompanies NetWare.

In the NetWare Administrator window, choose Create from the Object menu.
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4 In the New Object dialog box, select NDPS Printer and click OK.

B New Object

Parent:
(]
MDPS printers
Cancel
Clazz of new object:
= Contest...
i Help

Metware Server b

B Create NDPS Printer

MDPS Printer Mame:

|Splash

Cancel
Frinter Agent Source
Help
+ Create a New Printer Agent 4
" Existing NDPS Frinter Object in NDS

™ Public Access Printer

After Creating the MOPS Frinter Object
I Define Additional Properties
[ Create Anather MNDPS Printer

6 Select the Create a New Printer Agent option in the Printer Agent Source area.

7 Click Create.

The Create Printer Agent dialog box appears with the NDPS Printer Name you
chose displayed.

8 For the NDPS Manager Name, click the Browse button (“..”).

B Create Printer Agent

Frinter Agent [Pa) Mame:
|Splash

Cancel
MDPS Manager Mame:

| E Help

Gateway Types:

Pl

Movell Printer Gateway

IPF Gateway D
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9 In the Select Object dialog box, select the desired NDPS Manager object and click OK.

B Select Object

YES...

Available objects:

Browse contest:
I Cancel |

i Help |

P2 LALURENT-FRINTERS
g WODPS printers

58 nds

B8 ¥_manager_NWE

Change Context... |

10 In the Create Printer Agent dialog box, make sure that Novell Printer Gateway is selected in

the Gateway Types list and click OK.

B Create Printer Agent

Frinter Agent [Pa) Mame: oK

ISpIash

MDPS Manager Mame:

Cancel

Gateway Types:

Imanager_NW'B.YES

Movell Printer Gateway

IPF Gateway

dd.

Help

The Configure Novell for NDPS for Printer Agent dialog box appears.

11 Select (Generic) PS for the Printer Type and click OK.

B Configure Movell PDS for Printer A...

Frinter Type:

[NOME]
[Generic) PCL
Generic] PCL [PJL

[Generic) PS [PIL]
Acer LP-76

Apple Lazerariter
Port Handler Type:

Maovell Port Handler

.

AEG Olympia Laserstar 6
AEG Olympia Lagerstar e
AGFA Compugraphic 3400PS

(HE2

[I£3

Cancel Help
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12 Select Remote (LPR on IP) and click Next.

B Configure Port Handler, for Printer Agent ”S... E'

Connection Type
" Local [physical connection to server)

" Remate [rprinter on [P

" Forward Jabs to a Queue
Fort Type

I
I
I

SIS SN}

Lancel | Help | | Mest » | |

A new user interface in the Configure Port Handler dialog box appears.

13 Select Host Address or Host Name.

B Configure Port Handler, for Printer Agent ”S... E'

(* Hast Address

" Hast Mame

Frinter M arme:
PASSTHROUGH

Cancel | Help | < Back | | |

If you select the Host Address field, type the IP address of the EFI Splash RPX-iii.
If you select the Host Name field, type the DNS name. You can leave Printer Name as the
default, PASSTHROUGH, or type any printer name.

14 Click Finish.

15 Click the appropriate Windows operating system tab, choose the EFI Splash RPX-iii PPD, and
then click Continue.

The NDPS Information dialog box appears. The current EFI Splash RPX-iii PPDs selected
for the Windows operating systems for this NDPS Printer Agent are listed.

16 Click OK.
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Configuring a Novell NetWare print queue

This section describes how to configure a TCP/IP print queue on a NetWare server for
non-NDPS printing to the EFI Splash RPX-iii. The NetWare print queue uses the Novell
LPR Gateway and can be used to print via older versions of NetWare.

Requirements for setting up the NetWare print queue are as follows:
e The NetWare server must be configured for TCP/IP.

For more information, see the documentation that accompanies the NetWare server.
¢ NetWare Print Services for UNIX must be installed on the NetWare server.

For more information, see the documentation that accompanies the NetWare server.

* The NetWare Server must be able to resolve the IP address of the EFI Splash RPX-iii via
DNS.

Add an entry for the EFI Splash RPX-iii in the NetWare server's HOSTS file, located in
the sys:\ETC folder, or add a DNS entry for the EFI Splash RPX-iii in your network’s
DN server.

For more information, consult your network administrator.

To SET UP NON-NDPS NOVELL PRINTING
1 Log on to the NetWare file server with Administrator privileges.

2 Start NetWare Administrator.

To start NetWare Administrator, open the Sys:Public\Win32 folder on the NetWare server
and click the nwadmin32 icon.

3 Select the Container where you want the printer configuration to be located.
4 Choose Print Services Quick Setup from the Tools menu.

5 Choose UNIX from the Type menu.

1 Change Type to UNIX B Print Services Quick Setup (Non-NDPS) r>_<|

Frint Server name: |PS-NDF'S printers ‘E_EI Create |
Printer
Cancel

Mame: |F'2

Help
Type: ’m‘ Communication... 4
Banner type: ’h
Print Queue
Mame: |Q2

Yolume: [YES_NwiE_5v5. |
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6 In the Unix Communication dialog box, type the EFI Splash RPX-iii Host name (DNS name or
IP address), type the Printer name, and then click OK.

B Unix Communication

Host name:
-DK
[10.10:10.10
Cancel
Frinter name: 4
|Splash Help

7 At the NetWare Server Console, type “load pserver” and select the print server that you
just created.

8 At the NetWare Server Console, type “load unicon,” go to Start/Stop Services, click Insert,
and then start NetWare to Unix print services.

9 Browse for the print queue that you just created.

Connecting to a Fiery

The EFI Splash RPX-iii supports a direct connection to the Fiery or a connection over the
network. After the initial connection is made, the EFI Splash RPX-iii automatically
reconnects to the same Fiery each time it is started.

The EFI Splash RPX-iii installation process guides you through establishing the initial
connection. Keep in mind the following considerations:

¢ Determine if the connection is Direct Connect or Network Connect.

o If the Mac OS X computer has a single built-in network port, only Network Connect
is allowed.

o If the Mac OS X computer has multiple built-in network ports, verify that the second
port is available for connection to a Fiery.

* If the Fiery software requires an update to connect to the EFI Splash RPX-iii, the EFI
Splash RPX-iii downloads the update after the connection is established.

Connecting to a Fiery

The EFI Splash RPX-iii can connect to a Fiery by the Direct Connect method or the Network
Connect method. The following procedures cover both methods.

NoTe: Direct Connect is supported only with a digital press with an integrated Fiery. A stand-
alone Fiery must use Network Connect.
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To CONNECT TO A FIERY USING THE DIRECT CONNECT METHOD

1
2
3

Start the EFI Splash RPX-iii application.
Click Direct Connect.

If the Connect dialog box appears, follow the on-screen instructions to set the copier
IP address.

The EFI Splash RPX-iii establishes a connection and displays the message “Connection OK.”
The EFI Splash RPX-iii prints a Startup Page.

To CONNECT TO A FIERY USING THE NETWORK CONNECT METHOD FOR THE FIRST TIME

1
2

Start the EFI Splash RPX-iii application.

Click Network Connect.

The Fiery Chooser dialog box appears.

The EFI Splash RPX-iii scans for Fiery servers on the network.
Any Fiery on the same subnet appears in the list.

Select a Fiery or type the IP address and click Connect.
The EFI Splash RPX-iii establishes a connection and displays the message “Connection OK.”

The EFI Splash RPX-iii downloads the enabler.
The EFI Splash RPX-iii prints the Startup Page.

Changing the Fiery connection

To change the Fiery connection while the EFI Splash RPX-iii application is running, follow
the instructions in the following procedure.

To CHANGE THE FIERY CONNECTION

1
2
3

Start the EFI Splash RPX-iii application and log on with Administrator privileges.

Click the Stop button to stop processing.

Choose Controller Connection from the Splash Server.

The Fiery Chooser dialog box appears.

The EFI Splash RPX-iii scans for Fiery servers on the network.

Any Fiery on the same subnet appears in the list.

Select a Fiery or type the IP address and click Connect.

The EFI Splash RPX-iii establishes a connection and displays the message “Connection OK.”

The EFI Splash RPX-iii downloads the enabler.
The EFI Splash RPX-iii prints the Startup Page.
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SETTING DEFAULT PREFERENCES

This chapter describes how to set default preferences for jobs and EFI Splash RPX-iii
operation, using the Splash graphical user interface.

Setting default job settings

You can set default print options for jobs not sent with a EFI Splash RPX-iii PPD, such as
color correction, printing modes, and paper types. The interface is similar to the Job Options
dialog box when you print a job.

NoTe: The Number of Copies and Page Range options are not available in Default Job
Settings tabs.

Editing default job settings

The following procedure explains how to edit default job settings.

TO CUSTOMIZE DEFAULT JOB SETTINGS

1

Make sure that no jobs are currently printing or processing.

To stop a print job in the Active queue, press Start/Stop or choose Stop Processing from the
Server menu. To resume printing, press Start/Stop or choose Start Processing from the Server
menu.

Log on to the Splash Server with Administrator privileges.
Choose Edit Defaults from the Jobs menu.
The Default Job Settings dialog box appears.

Click each of the tabs (File, Page, Imposition, Tray, Output, Color, Quality, and Extras) and set
the options.

Click OK to save your custom set of default settings.

Job defaults for PostScript printing

Define default job settings at the EFI Splash RPX-iii. Defaults are applied to the following
types of jobs:

¢ Jobs from UNIX clients

* Jobs sent from Mac OS or Windows 2000/XP/Server 2003/ Vista computers using
non-Splash PPDs
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* Graphics files (EPS, JPEG, 1-bit TIFE, TIFF, TIFF/IT, DCS 2.0, ExportPS, CT/LW,
CT/NLW, PSD, PDE, PDF2Go, and PDF-X1/a formats) or PostScript files that are
placed in the Drop folder or dragged to the Active or Hold queues

* Jobs sent from the printer driver with Printer’s Default selected

Setting up EFI Splash RPX-iii preferences

A

The Splash Server Preferences dialog box allows you, as the administrator, to configure the
EFI Splash RPX-iii. The dialog box is configured with the following tabs:

* Server includes file converters, job processing preferences, job error preferences, and the
Server Name.

* Page allows you to choose settings for printing cover pages, previews, custom page sizes,

and mapping jobs.

* Network displays Remote Queue Management, Enterprise Networking, AppleTalk
Registration, and Enable Web Access settings.

* Color includes various options for color printing and calibration.
* Appearance includes options for displaying font styles in the job queues.

* Jobs allows spooled jobs to be deleted automatically based on given parameters of time or
number of jobs.

* Button Bar allows you to select the icons that appear in the Splash Server interface.

* Job Logging displays settings for starting, storing, and viewing Job Log files.

To vieEw AND EDIT EFI SPLASH RPX-iii PREFERENCES

1

o v A~ W

Make sure that no jobs are currently printing or processing.

If printing is in progress at the EFI Splash RPX-iii, do #or modify the EFI Splash RPX-iii
preferences. Doing so may cause unexpected results in the printed output. Editing server
preferences does not cause jobs to be reRIPped.

Choose Login from the Server menu.

Type the Administrator password.

Click OK.

Choose Preferences from the Splash Server menu.

In the Splash Server Preferences dialog box, click the tab that corresponds to the preferences
that you want to set, as described in the following sections.

Setting Server preferences

The options on the Server tab in the Splash Server Preferences dialog box allow you to define
the Server Name and set file converter and job processing preferences.
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Assigning a server name

The name you type in the Server Name field is visible to remote clients who connect to the
EFI Splash RPX-iii over an AppleTalk or Bonjour network. “Splash Server” is the default
name. If you connect more than one EFI Splash RPX-iii to the same network, you must
assign each a different name in order for both to appear on the network.

To change the server name, type a unique name in the Server Name field. Assign the EFI
Splash RPX-iii a name that clearly indicates that it is a color printer.

Print Startup Page prompts the server to print a Startup Page when the server starts.
The Startup Page displays a recognizable color pattern and basic printer and server
configuration information.

Always Hold Incoming Jobs places a temporary hold on all print jobs received. Incoming jobs
go to the top of the Hold queue and are not RIPped or printed. This allows the EFI
Splash RPX-iii administrator to review all jobs before they print.

NoTe: When this option is selected, you must drag a print job from the Hold queue to the
Active queue or select the job in the Hold queue and choose Remove Hold from the Jobs
menu to print it.

Secure Erase specifies whether the EFI Splash RPX-iii deletes files permanently, so that they
cannot be recovered. This option affects spool files for jobs, files generated by processing spool
files, and scan files.

Setting GA File Converter preferences

To start the GA (Graphic Arts) File Converter automatically, select the GA File Converter
option. When the Converter starts, it appears in the Mac OS X Dock. The Converter
supports the following formats: 1-bit TIFE, TIFF/IT, PDF-X1/a, CT-LW, CT/NLW,
PDF2Go, and ExportPS.

To configure GA File Converter preferences, select GA File Converter in the Dock, and then
choose Preferences from the GA File Converter menu. You can set the following options:
Conversion options

* Resolution: 200, 400, or 600 dpi

* Anti-Aliasing: Bilinear or Nearest Neighbor

Setting the Job Content (Define Errors) preferences

When you click Define Errors, you can specify how to manage jobs that contain errors and
may not print correctly. For each error type, you can select to Ignore the error and print the
job, Warn that there is an error condition, but print the job anyway, or simply Error the job
without printing. This allows you to prevent jobs from printing that have errors that may be
difficult to find the root cause.
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Various conditions represent errors in some workflows and not others. For example, the
presence of spot colors in a job that is proofing a CMYK-only press almost always guarantees
incorrect results in the proof. RGB colors in a job in any press proof is likely to produce less
desirable output. Recognizing these errors before you print allows you to detect and correct
errors earlier in the process.

When errors and warnings occur, use other tools such as PreFlight and Color Postflight to

identify the errors. See Color Guide.
For each option, select one of the following:
Ignore (Q) ignores error, prints, and follows normal File Handling settings.

Warn () prints the job and returns the job to the Error queue with a warning message
describing the problem.

Error (€)) does not print the job and returns the job to the Error queue with an Error
message describing the problem.

Error handling options include:

Section Option Default setting
Color RGB color Ignore
Spot colors Ignore
Spot color not defined Ignore
Media type not calibrated Ignore
Untagged RGB colors Ignore
No output intent on Ignore
PDF/X-3 file

(This option is only selected if
the PDF/X-3 Compliant job

option is selected.).

Not PDF/X-3 Compliant Ignore

NoTE: Setting Not PDF/X-3
Compliant to Error or Warn
only affects jobs for which the
PDF/X-3 Compliant job option

is enabled.
Font Font not available Ignore
Not not included in job Ignore
Quality Low resolution images Ignore

Minimum resolution 72
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Finishing allows the EFI Splash RPX-iii to handle copier errors based on the following
preference settings: Strict and Relaxed.

Strict error handling means the job does not print if the job settings cannot be satisfied.

Relaxed error handling means the jobs will print if the conflict is handled in a reasonable
manner. When Relaxed is selected, the following conflict types will result in error:

* DPage size and type are not available in the digital press.
* The job violates Booklet folding limitations.

All other jobs will print with finishing options disabled as necessary to make them print.
Most errors occur because paper sizes and types conflict with the selected finishing
options, in which case the job prints with the finishing options disabled.

Setting the Error Dialog Timeout preference

Type a unit of time (a minimum of one minute) in the Error Dialog Timeout field to specify
how long processing is delayed at the EFI Splash RPX-iii when a printing error occurs. If the
error is not corrected within this time limit, the job moves to the Error queue. To minimize
the delay of processing subsequent jobs when an error occurs, set the timeout to one minute.
To ensure that jobs remain active until the error is corrected, select Never Timeout.

Beep While Displayed alerts the EFI Splash RPX-iii to “beep” every 10 seconds when an error
message is displayed. The 10-second interval cannot be changed. If you close the dialog box
or the dialog box times out, the beep stops.

Setting Page preferences

The options on the Page tab in the Splash Server Preferences dialog box allow you to set
Page preferences, including the following:

Print Cover Page prints a standard cover page as the first page of any job.

Cover pages include the date and time printed, job owner’s name, job name, and number
of pages.

Handle Paper Errors at Print Time processes jobs when the correct paper size is not available on
the digital press. When the job is ready to print, EFI Splash RPX-iii prompts you to load the
correct paper. If this option is disabled, jobs that request a paper size that is not loaded in the
digital press are immediately moved to the Error queue. If this option is enabled, Map A4/
Letter and A3/Tabloid has no effect.
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Map Aé4/Letter and A3/Tabloid is useful for frequent printing on Letter and Tabloid paper sizes
with occasional A4 or A3 jobs, or vice versa. If this option is selected and no A4 paper is
loaded at the digital press, an A4 job is automatically converted to print on Letter paper. If A4
paper is loaded, a Letter size job is converted to print on A4. If Tabloid paper is loaded, jobs
with A3 paper selected print on Tabloid paper. If A3 paper is loaded, jobs with Tabloid paper
selected print on A3 paper.

In each case, the job is scaled proportionally to fit the paper size and the image is centered on
the page to prevent clipping. After the job prints, a spool file for the job appears in the Error
queue with a message indicating that the paper size for the job was converted.

Relaxed Page Size for Dropped Files prints dropped files on a larger page size if an exact page
size match cannot be found. The option applies to dropped TIFF, EPS, or PDF files and files
processed by the GA File Converter.

If you select this option, the job prints centered on the page, but is not scaled to fit the page
size. Many dropped files are not exact matches for standard page sizes and produce printing
errors. For example, many PDF creators subtract margins when creating the PDF page size,
resulting in a page request for 8.2 x10.7 or similar paper size. If this option is selected, and an
exact match for the requested page size is not available, the job prints on the first page size
loaded on the printer that is large enough to fit the job. If none of the available page sizes is
large enough, the job prompts a Page Size error message.

NoTe: Dropped PostScript and DCS 2.0 files are not affected by this option.

Previews allows the administrator to save previews for all pages or for the first page only and to
specify what quality level preview to generate.

The Previews control options are:
* Save: All Pages or First Page Only
* Quality: Higher or Lower

Custom Page Sizes allows the administrator to define new custom page sizes at the EFI
Splash RPX-iii and use them for printing and calibrating. The EFI Splash RPX-iii tracks the
custom page sizes that have been created by a client printer driver and printed to the EFI
Splash RPX-iii or the custom page sizes programmed into the digital press, and adds those to
the custom page size list.

NoTEe: The list of custom page sizes at the server is not available through the EFI

Splash RPX-iii print driver. They are only accessible when you modify Job Properties at the
EFI Splash RPX-iii. Users must define their own custom page sizes in the print driver. For
instructions, see the Printing Guide.
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2 Y dimension
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To ADD A CUSTOM PAGE SIZE
1 Click the plus sign (+) and type a name for your custom page size.

2 Enter the page dimensions according to the feed direction illustrated.

Custom Page Sizes
+= Feed Direction

poster

10.0 in.

@ 19.0 in.
[+]-]
&)

If X > Y, the paper is long-edge feed.
If X <Y, the paper is short-edge feed.

NoTe: The dimensions are constrained to paper sizes supported by the digital press.

To DELETE A CUSTOM PAGE SIZE
¢ Select the custom page name from the list and click the minus sign (-).

To RENAME A CUSTOM PAGE SIZE
¢ Double-click the custom page from the list and type a new name.
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Setting Network preferences

The options on the Network tab in the Splash Server Preferences dialog box allow you to set
network printing and queue management options.

Setting Network preferences

The Network preferences in the Splash Server Preferences dialog box allow you to set the
Enterprise Networking, AppleTalk Registration, Windows Workgroup, Allow RIP While

Receive, and Enable Web Access options, as follows.

Enterprise Networking: With this option selected, the EFI Splash RPX-iii can receive print
jobs from clients on TCP/IP networks via LPR, in addition to clients on an AppleTalk
network. The EFI Splash RPX-iii maintains both network connections simultaneously.

Parse for Document User Name: Document User Name is extracted from each print job as
it is received at the EFI Splash RPX-iii. When this option is cleared, Enterprise Networking
determines the owner name from the network connection.

Use IPv6: When IPvG6 is selected, the EFI Splash RPX-iii allows entry of an IPv6 address for
selection of a Fiery in Network Connect mode in the Connection dialog box. It also allows
the use of IPv6 for both LPR and Port 9100 spooling and the connection to the Fiery.

NoTE: The IPv6 address for the Mac OS X must be configured and enabled in the Mac OS X
Network System Preferences.

AppleTalk Registration: Select this option to register the EFI Splash RPX-iii name on the
AppleTalk network. If this option is cleared, remote users cannot print over AppleTalk to the
EFI Splash RPX-iii. This option may be useful in network environments where it is not

desirable to route AppleTalk.

Allow RIP While Receive: If this option is selected, the EFI Splash RPX-iii processes the job
while it is being received over the network. If your printing environment includes both large
and small jobs, selecting this option uses the processing power of the EFI Splash RPX-iii most
efficiently.

Enable Web Access: For information about this option, see “Enabling Web Access” on
page 37.

Windows Workgroup: Type the name of the Windows Workgroup to which the EFI
Splash RPX-iii belongs. This is the name that appears on the network when Windows users
browse for the EFI Splash RPX-iii.

Setting Web Queue Management preferences

For information about setting the Web Queue Management preferences, see “Controlling
Web Queue Management privileges” on page 39.
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Setting Color preferences

The options on the Color tab in the Splash Server Preferences dialog box allow you to set
the Print preferences. For more information about these options, see the Color Guide.

Digital Press Screening includes the following digital press screening settings:
* 200 Cluster Dot specifies 200 Ipi cluster dot for text, objects, graphics, and images.
* 200 Rotated Line specifies 200 lpi rotated line for text, objects, graphics, and images.

* Enhanced Text and Graphics specifies 300 Ipi cluster dot for text, objects, and graphics,
and 200 Ipi cluster dot for images.

* Enhanced Text specifies 300 Ipi cluster dot for text and 200 Ipi cluster dot for objects,
graphics, and images.

Use the 200 Cluster Dot and 200 Rotated Line settings for general printing and proofing.
The Enhanced settings may provide better output for text and graphics, but midtone colors
may be less accurate.

NoTe: Recalibrate all profile sets after changing the Digital press Screening setting.
NoTEe: The Digital press Screening option is ignored when the Screened job option is selected.

Grayscale As K in CMYK color corrects the black channel as CMYK black versus RGB black.
Select this option if most of your documents are designed using CMYK colors. Clear this
option if you print mostly from office applications that use RGB colors.

Progressives allows printing as many as four separate color passes per page. Users can examine
the result of progressively adding color to the output and can customize progressive prints to
match their workflow.

Select the number of sheets to print (Sheets 1-4), and then select the number of colors to
print on each sheet (C, M, Y, or K). Choose Print Progressives in the job options before
printing jobs with the progressives defined here.

Setting Calibration preferences

Warn after _ Days allows you to select a specific number of days from the last calibration date
to remind you to recalibrate the printer. When the time set in Days Last Calibrated Warning
expires, the date and time listed in the Last Calibrated area of the EFI Splash RPX-iii
application main window are displayed in red.

Automatically launch ColorCal launches ColorCal automatically on the day you specified for
Warn after _ Days option.

Allow Remote Calibration allows you to run ColorCal on any Mac OS v10.4 computer or later
and update the EFI Splash RPX-iii remotely.

Disable this option if you only want to allow calibration from the EFI Splash RPX-iii and do
not want a remote calibration station to control calibration for your EFI Splash RPX-iii.



SETTING DEFAULT PREFERENCES

Setting Appearance preferences

The options on the Appearance tab in the Splash Server Preferences dialog box allow you to
set the color and size of the text that appears in each of the print queues.

Setting Button Bar preferences

To customize the icons that are displayed, drag the icons to or from the Loaded Buttons list.

Setting Jobs preferences

The options in the Splash Server Preferences dialog box allow you to set the
following preferences:

Auto Delete Jobs allows spooled jobs to be deleted automatically based on how long the job
has been at the server or number of jobs in the server queues.

Auto Delete Scans allows scans to be deleted automatically based on the parameters of time.

Daily Auto Delete Time allows you to specify a time to delete the jobs or scans as defined in the
other controls to allow for minimum disruption to the normal EFI Splash RPX-iii workflow.
If the EFI Splash RPX-iii is shut down at the time the deletion is scheduled to occur, the
deletion occurs the next time the EFI Splash RPX-iii is started.

For scan jobs, the EFI Splash RPX-iii connects to the Fiery and deletes the scans from the
Fiery. In the Network Connect configuration, use with caution because the results may not be

desirable.

Setting Job Log preferences and reading a log file

The Splash log file in the Splash folder records information about each print job. The file

name is “SplashPrint.log.” For more information, see “Reading the log file” on page 33.

If you quit the EFI Splash RPX-iii application and restart it, the log file continues to add
information to the log and does not reset it. If you move the log file out of the Splash folder,
the server automatically begins a new log file when it prints the next job.

To MANAGE A LOG FILE
1 Start the EFI Splash RPX-iii application.
2 Log on with Administrator privileges.
3 Choose Preferences from the Splash Server menu.
The Splash Server Preferences dialog box appears.
4 Click the Job Logging tab.

The Job Log File dialog box appears.
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In Delete Log Entries, specify how long the EFI Splash RPX-iii is to maintain the current print
log file.

Click OK.

The log file is saved in the Splash folder on the hard disk drive every time a print job is
completed. You can view the log file in any application that reads text files, or you can import
the log file into a spreadsheet application for billing purposes.

Reading the log file

The log file contains the following information about each job:

e User Name displays the network identity of the client that sent the job to the EFI
Splash RPX-iii.

* Document Name displays the name of the file sent.

* Status indicates whether a job was completed successfully (OK), or canceled, errored, or

placed on hold (CANCELED.
* Date indicates the date that the job was sent to the printer.
* Start Time displays the time that the EFI Splash RPX-iii started processing the job.

* RIP Time displays the amount of time (in the format minutes:seconds) that the EFI
Splash RPX-iii spent processing (RIPping) the job.

* Print Time displays the amount of time (in the format minutes:seconds) required to print
the job; starts from the time printing begins at the printer, and ends at the time printing
completes at the printer.

* Color Model indicates whether a job was printed in grayscale or color.
* Tray 5 shows Yes or No when Tray 5 was used for the job.

* Duplex indicates whether the job was printed as double-sided output using the Manual
Duplex feature.

* Paper Type displays the type of paper used for a job printed to Tray 5.
* Page Size displays the page size on which a job was printed.

* Copies display the number of job copies printed. This option is only displayed when the
log is exported, not when you print the log or use the Job Log Viewer.

* Bytes indicates the file length. This option is only displayed when the log is exported, not
when you print the log or use the Job Log Viewer.

* Serial Number displays the unique number assigned to the printed job. This option is only
displayed when the log is exported, not when you print the log or use the Job Log Viewer.
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* Pages Rendered displays the number of pages in a document.This option is only displayed
when the log is exported, not when you print the log or use the Job Log Viewer.

* Status Code indicates the error status of job upon completion. This option is only
displayed when the log is exported, not when you print the log or use the Job Log Viewer.

* PPD Paper Type indicates the media type. For the Xerox 700 Digital Color Press this is
combined Media Type and Media Weight. This option is only displayed when the log is
exported, not when you print the log or use the Job Log Viewer.

* PPD Paper Size indicates the paper size. This option is only displayed when the log is
exported, not when you print the log or use the Job Log Viewer.

* Color Images Printed displays the total number of pages printed in color.
* Black Images Printed displays the number of pages that were printed using black ink only.

* Cover Page indicates if a cover page was printed for a job.
Note: The Cover Page is not counted as a Black Image Printed. To include the cover page in

billing records, it is necessary to add one to the Black Images Printed if the Cover Page entry is
set to Yes.

* Job Comment displays any information typed in the Document Comment field at the
printer driver.

¢ Account Number displays the account number associated with the file (if available).

Mixed Media and Set Builder jobs that use more than one paper type are displayed in the log
with one line per paper type.

Exporting the log file

To use the log file information in another application, you must export it. The exported file is
in a tab-delimited format that can be opened in other applications (for example, database or
spreadsheet applications, such as Microsoft Excel).

To EXPORT THE LOG FILE

1 Choose Export Log from the File menu.
The Job Log is saved automatically to the desktop.

2 Open the exported file in a spreadsheet application as a tab-delimited text file.

Viewing the Job Log

Show Job Log allows you to view, sort, and print the Job Log. The toolbar icons are:

*  Print: Print the job log entries currently shown.
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To VIEW THE JoB LoG

e Choose Show Job Log from the Splash File menu.

For more information about the Job Log, see the Job Management Guide.

Understanding Splash job entries in the Fiery Job Log

The Fiery Job Log contains entries for all jobs sent by the EFI Splash RPX-iii, as well as

jobs sent directly to the Fiery. In the Fiery Job Log, all Splash jobs have the format
SINNNNNNNNjobname, where the eight Ns are a hexadecimal number unique to the job.
The user name for the job is the user name reported by the EFI Splash RPX-iii.

The Splash log file contains only jobs sent to the EFI Splash RPX-iii and does not contain
jobs sent directly to the Fiery.

Printing the Job Log

The Print Job Log option allows you to sort job information by customer, date, time, or
account number and add a subtotal for each customer or account number. You can print all
entries in the Job Log or only those entries added since the last Job Log printed.
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USING THE WEB QUEUE MANAGER

This chapter explains how to configure the EFI Splash RPX-iii to allow remote users to
connect to the server. The Web Queue Manager installed with the EFI Splash RPX-iii server
software allows remote users on a TCP/IP network to view and control print jobs at the EFI
Splash RPX-iii.

With Web Queue Manager, you can perform the following functions:
* Review the status of print jobs sent to the EFI Splash RPX-iii.

* Hold print jobs.

* Release held print jobs.

* Review and change print options for a job in the print queue.

* Log on with Administrator privileges and change Server Preferences.

For information about using Web Queue Manager, see the Job Management Guide.

Preparing the Web Queue Manager

To prepare the Web Queue Manager for use with the EFI Splash RPX-iii, you must configure
the EFI Splash RPX-iii to run on a TCP/IP network and enable the Web Queue Manager
option. For more information, see “Configuring the EFI Splash RPX-iii for TCP/IP and LPR
printing” on page 9.

The Web Queue Manager uses Apple’s Web Sharing software. To use the Web Queue
Manager from a client computer, you must have an established intranet or Internet
connection, plus Safari v1.2 or later, or Microsoft Internet Explorer v6.0 or later.

The Web address (URL) for the Web Queue Manager is htep:// followed by the EFI

Splash RPX-iii IP address. For more information, contact your network administrator.

Configuring the Web Queue Manager
To configure the Web Queue Manager for use with the EFI Splash RPX-iii, do the following:
Set the IP Address for the EFI Splash RPX-iii.
* Enable Web Access in the EFI Splash RPX-iii Server Preferences.
* Enable Web Sharing in the Mac OS X System Preferences.
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Set the IP Address for the EFI Splash RPX-iii

To use Web Queue Manager, you must acquire the manual IP address configured on the EFI
Splash RPX-iii.

To configure the manual IP address for the for the EFI Splash RPX-iii, see “To configure the
EFI Splash RPX-iii for the TCP/IP network” on page 10.

Enabling Web Access
The following procedure describes how to enable Web Access at the EFI Splash RPX-iii.

To ENABLE WEB ACCESS AT THE EFI SPLASH RPX-iii
1 Start the EFI Splash RPX-iii application and log on with Administrator privileges.
2 Choose Preferences from the Splash Server menu.
The Splash Server Preferences dialog box appears.

3 Click the Network icon and select the Enable Web Access option.

Q@0 9 Fd &

Server Page Network Color Appearance ButtonBar Jobs Job Logging

Services

E Enterprise Networking
(] Parse for Document User Name
] Use IPvE

EAppIeTalk Registration

™ Allow RIP While Receive

E Enable Web Access

Windows Workgroup:

WORKGROUP

Web Queue Management

O Access All Files
e Access Own Files
O No Access

4 Click OK.

The Sharing control panel opens.

Enabling Web Sharing
The following procedure describes how to enable Web Sharing for the EFI Splash RPX-iii.

To ENABLE WEB SHARING FOR THE EFI SPLASH RPX-iii
1 Choose System Preferences from the Apple menu.

2 Select the Sharing control panel.
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3 Mac 0S 10.5: Select the Web Sharing option.

L &N&) Sharing

Computer Name: ga-mac-images-10.5.2

‘Computers on your local network can access your computer at: ga-
mac-images-10-5-2.local

On | Service @ Web Sharing: On

] DVD or CD Sharing Web Sharing allows users of other computers to view web pages in the Sites
[C] Screen Sharing folders on this computer.

1 File Sharing

[ Printer Sharing Your computer's website:

v p://10.11.96.62/
i Web Sharing http://10.11.96.62

] Remote Login

] Remote Management Your personal website:
[] Remote Apple Events http://10.11.96.62/~administrator/

] Xgrid Sharing
Internet Sharing

[ ®
Click the lock to prevent further changes.

Mac 0S 10.4: Click the Services tab, select the Personal Web Sharing option, and then
click Start.

The Personal Web Sharing On title appears and the Start button changes to a Stop button.

880 Sharing =)

Computer Name: JP's Computer

Rendezvous Name: JP's Computer .local

Network Address: dhcp-10-10-83-42.efi.com
'—Senices—{ Firewall l Internet

Select a service to change its settings.
On | Service Personal Web Sharing On
E Personal File Sharing
Sto|
E Windows File Sharing
T Personal Web Sharing Click Stop to prevent users of other

= " computers from accessing Web pages in the
L Remote Login sites folders an this computer.
[ FTP Access

] Remote Apple Events
[} Printer Sharing

View this computer's web sites at http://dhcp-10-10-83-42.efi.com/ or your personal web
site at http:/ /dhcp-10-10-83-42.efi.com/~francesc/

@ Click the lock to prevent further changes.

4 Close the Sharing control panel.

The Web Queue Manager is enabled. Remote users on a TCP/IP network with Safari or
Microsoft Explorer installed can connect to the Web Queue Manager to remotely view and
manage print jobs on the EFI Splash RPX-iii.
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NoTe: The EFI Splash RPX-iii Administrator is usually also the Web Queue Manager
Administrator. The EFI Splash RPX-iii Administrator sets privileges for remote users to edit
print jobs in the EFI Splash RPX-iii print queues with the Web Queue Manager.

To use the Web Queue Manager with Administrator privileges, log on to the Splash Server
Preferences in the Web Ul using "administrator” for the user name and the server
administrator password.

Controlling Web Queue Management privileges

The Web Queue Management options in the Network Preferences dialog box allow you to
control which users can change or delete jobs in the Splash print queue from the Web Queue
Manager.

TO CONFIGURE THE REMOTE QUEUE MANAGEMENT OPTION
1 Start the EFI Splash RPX-iii application and log on with Administrator privileges.
2 Choose Preferences from the Splash Server menu.
3 Click the Network icon.
The Splash Server Preferences dialog box appears.
4 Select a Web Queue Management option.

* Access All Files: Users can put any job on hold, delete any job, change its position in the
Print queue, and change print options for any job.

* Access Own Files: Users can hold, delete, edit, or change the position in the Print queue for
their own jobs. Users must log on to make changes to the Print queue.

* No Access: Users can view information for print jobs, but they cannot perform any Print
queue management functions.

5 Click OK.
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ADMINISTERING THE EFI SPLASH RPX-iii

This chapter describes EFI Splash RPX-iii administration tasks.

Changing the Administrator password

The default Administrator password for the EFI Splash RPX-iii is blank (no password). Set
the password to protect the EFI Splash RPX-iii against unauthorized changes.

TO CHANGE THE ADMINISTRATOR PASSWORD

1 Choose Login from the Server menu.

2 Click Change.

3 Type the old password, if any. Type the old password once and the new password twice.
NoTe: The default Administrator password for the EFI Splash RPX-iii is blank (no password).

4 Enter and verify the new password.



ADMINISTERING THE EFI SPLASH RPX-ifi

Managing users and accounts

To MANAGE USER ACCOUNTS

1
2
3

1 Plus sign (for adding users)

2 Minus sign (for deleting
users)

Log on to the EFI Splash RPX-iii with Administrator privileges.
Choose Users from the Server menu.

To add a user, click the plus sign “+” and type the user name in the Name field. Type the
password in both the Password and Verify fields.

Users

Username _________scan| {Cidentity | Scanning

francesc v

Name: francesc

Password: «

Verify:

1 :

BE

A maximum of 24 characters is allowed in the Name field. A maximum of 8 characters

is allowed in the Password field. An unlimited number of users can be added to the Users list.
To remove a user, select the user name and click the minus sign “-".

To set scanning privileges, click Scanning and type the appropriate information.

For more information, see the Job Management Guide.

Click OK.



ADMINISTERING THE EFI SPLASH RPX-ifi

To MANAGE ACCOUNT NUMBERS

1
2

1 Plus sign
(for adding accounts)

2 Minus sign
(for deleting accounts)

4
5
6

Log on to the EFI Splash RPX-iii with Administrator privileges.
Choose Accounts from the Server menu.
The Accounts dialog box appears.

To add an account, click the plus sign “+” and type the account number in the Number field
and a description in the Description field.

Accounts

Account

There are no accounts set up
for this Splash server.

OV S—
BE Caanee) oK)

A maximum of 32 characters is allowed in the Account field. A maximum of 100 characters
is allowed in the Description field. The account description allows you to provide more
information about the account than can be stored in the account name. The account
description is not required and is not used elsewhere by Secure Access.

NoTE: Account names are limited to printable characters but may contain characters that are
not alphanumeric characters.

Click the account name in the list to change it.
To remove an account, select the account number and click the minus sign “-",

Click OK.
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Secure Access

Secure Access allows the EFI Splash RPX-iii Administrator to limit who can print to the EFI
Splash RPX-iii by defining combinations of user names, passwords, and account numbers that
must be entered and verified before a job prints. You can define for each user whether they are
part of a Color group or Black and White only group to limit some users to print non-color
documents only.

You can also use Secure Access without the verification feature to improve job logging, by
requiring user names and account numbers before a job is printed.

Secure Access accounts are established and managed at the EFI Splash RPX-iii. You are
prompted for the required information at the workstation. Validation of the information, if
required, is performed by the EFI Splash RPX-iii. If the information is not valid, users are
prompted to reenter the correct information before the job prints.

TO START SECURE ACCESS
1 Log on to the EFI Splash RPX-iii with Administrator privileges.

2 Choose Secure Access from the Server menu.
The Secure Access dialog box appears.
3 Select the appropriate settings.

4 Select Verify to indicate whether you want the option to be verified.

Secure Access

C] Enable Secure Access

Required Information: Verify
[ user =
[ Password I

] Account Number

] Exempt Drop Folder Jobs

Error Message Client Receives

Server Administrator's Email Address

(Cance) @06

If you select Password, you must select User, and both must be verified. For jobs printed using
the EFT Splash RPX-iii printer driver, the information is verified at the client before the job
prints. This ensures that the job prints successfully when it reaches the EFI Splash RPX-iii.
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When the Verify option is cleared, the EFI Splash RPX-iii processes any job for which the
selected information is not blank. The User and Account Number are output to the log file.

NoTe: Files placed in a Drop folder or Hot Folder, or dragged to one of the print queues,
always produce an error when Secure Access is selected, unless you also select Exempt Drop
Folder Jobs or enter the required information for the default job options or Hot Folder. If this
option is selected, files sent to the EFI Splash RPX-iii via drop-printing are printed, regardless
of the other Secure Access settings.

Editing Secure Access client error messages

When a user incorrectly enters Secure Access information, the EFI Splash RPX-iii returns an
error message to the user’s computer. To provide specific contact information for users of a
particular EFI Splash RPX-iii, you can edit this error message. A maximum of 255 characters
is allowed in the Error Message and E-mail Address fields.

Using Secure Access at client workstations

When Secure Access is configured at the EFI Splash RPX-iii, users must install the Secure
Access printer driver provided with the EFI Splash RPX-iii. For detailed installation
instructions, see Gerting Started.

Printing with Secure Access

Printing with the Secure Access printer driver is the same as printing with the standard driver,
except that the driver prompts you for Secure Access information. Other job options work
similarly.

With the first job sent to a particular printer driver, the Secure Access printer driver prompts
you for the EFI Splash RPX-iii IP address if it cannot determine it automatically.

With every job, the Secure Access printer driver prompts you for the logon information that is
defined at the EFT Splash RPX-iii. If the information you enter is not correct, the printer
driver prompts you to re-enter the correct information, specifying what entry was first found
to be incorrect, along with the error message set up at the server. The prompt remains until
you enter the correct information or click Cancel. When you enter the correct information,
the job prints as it would with the standard printer driver.
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Printing the Configuration Report

The Configuration Report feature allows you to print saved preferences and other server

information. The Configuration Report is a PostScript file that is sent to the Drop folder and

printed on the digital press’s default paper size.

NoTe: All options set to factory default are displayed in black text. Any option that is not a

factory default setting is displayed in blue text. The file name is “Splash Config Report.ps.”

To PRINT THE CONFIGURATION REPORT

1 Log on to the EFI Splash RPX-iii with Administrator privileges.

2 Choose Print Configuration Page from the File menu.

Backing up and restoring preferences

If you must reinstall server software, make a backup of the preferences so that you can restore

them after the software is installed. If you have more than one EFI Splash RPX-iii, you can

back up the preferences for one server and copy them so that other servers can use the same

preferences.

The following information is backed up:

Server preferences

Color profile settings and output profile settings
Screening preferences

Screening sets

Tray Alignment

Profile sets (server must be recalibrated)

Job defaults

Hot Folders

Print info

Secure Access

Job Log

RGB, CMYXK, and Output profiles that have been added to the server
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To BACK UP PREFERENCES

1 Log on with Administrator privileges.
2 Choose Preferences from the Splash Server menu.
3 Click the Server tab.

4 Click the icon in the lower-left corner.

)

5 Choose Export.

6 Name the preferences file, select a location to which to save the preferences file, and then
click OK.

To RESTORE PREFERENCES

1 Log on with Administrator privileges.

2 Choose Preferences from the Splash Server menu.
3 Click the Server tab.

4 Click the icon in the lower-left corner.

5 Choose Import.

6 Select the preferences file and click OK.

The preferences are restored.

7 If prompted, select whether to replace the current server name with the server name from the
imported preferences.
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Updating software

The EFI Splash RPX-iii provides an easy mechanism to keep your Splash Server and Fiery
Controller software up to date. The EFI Splash RPX-iii automatically checks for updates once
a week, or you can check for updates manually.

When the EFI Splash RPX-iii checks for updates and new software is available, a dialog box
lists the updates. Download all updates or select only the ones that you want.

If you download Fiery updates and Splash Server updates, the Fiery updates are installed first.
If necessary, the Fiery restarts and prints a Start Page. Finally, Splash Server updates are
installed.

The Splash Server Macintosh must be configured for https access to the Internet:
* The Macintosh must be connected to a network with Internet access.
* If the network uses a proxy server, the https proxy must be configured correctly.

For information, see “To check for updates and configure proxy server settings” on

page 47.

TO CHECK FOR UPDATES AND CONFIGURE PROXY SERVER SETTINGS

1 Choose Login from the Server menu and log on with Administrator privileges.

2 Choose Check for Updates from the Splash Server menu.

Software Update

Software Update checks for new and updated versions of
the Splash Server and related software.

() Don't check for updates
@ Check weekly for updates
) Automatically update at 1:00 AM

Check Now

)
T

Last check: Software Update not checked.

( Proxyinfo_. )

Loy e
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3 Click Proxy Info.

006 Proxy Info

Proxy Info

If you see errors during software update, your computer's network
Praxy settings might not be correct. To verify or change the Proxy
settings:

1. Open System Preferences > Network (or click the Open Netwark
buttan below)

2. From the Show popup, choose Built-in Ethernet 1, or whichever
interface you are using for general Internet connectivity.

3. Click the Proxies tab.
4. Make sure that FTP Proxy and Secure Web Proxy (HTTPS) are

enabled and configured correctly. If you do not know the correct
settings, please contact your system administrator.

Open Network.. E

4 Click Open Network or choose System Preferences > Network from the Apple menu.
5 Configure the Proxy server settings, and then click Done.
6 To search for new updates, click Check Now.

7 If you want the Splash Server to search for updates automatically, select Check weekly for
updates.

To download updates automatically, select Automatically Update at and specify a time. The
EFI Splash RPX-iii queries the update server once a week at the specified time.

NoTe: The downloaded updates are not installed. You are asked to install them after the
download is complete.

8 Click Done to close the Software Update dialog box.

To DOWNLOAD UPDATES

1 Select the name of the update to see a detailed description.
2 Select each update that you want to install.
3 Click Install.

All selected updates are downloaded and installed. If you cancel the update process or do not
select some of the updates, those updates are available the next time you check for updates.

If you select Splash Server updates, follow the on-screen instructions.
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Downloading fonts

The EFI Splash RPX-iii cannot process print jobs while font downloading is in process. If the
EFI Splash RPX-iii is processing a job, choose Stop Processing from the Server menu or click
Start/Stop.

Adding fonts to the EFI Splash RPX-iii

The EFI Splash RPX-iii provides 136 Roman PostScript fonts and two multi master fonts.
Print jobs that use the PostScript fonts provided with the EFI Splash RPX-iii print faster
because these fonts are resident at the EFI Splash RPX-iii and are not downloaded with the
print job. If you frequently use fonts that were not provided with the EFI Splash RPX-iii,
download these fonts to speed up printing.

Command WorkStation is used to download fonts from Windows computers. Splash Font
Downloader is used to download fonts from Mac OS X computers.

Downloading fonts from a Windows client using Command WorkStation

Download fonts from Windows clients by using Command WorkStation.

TOo DOWNLOAD FONTS USING COMMAND WORKSTATION

1
2
3

Log on to the EFI Splash RPX-iii with Administrator privileges.

Log on to Command WorkStation with Administrator privileges.
Choose Manage Fonts from the Command WorkStation Server menu.
The Server Fonts dialog box appears.

Click Add.

Browse to the font that you want to add.

Select the font and click Add.
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Downloading fonts from a Mac 0S X client using the Splash Font Downloader utility

Download fonts using the Splash Font Downloader utility that is located in the Utilities
folder on the client DVD. It can run on systems with Mac OS X 10.3.9 or later.

To DOWNLOAD FONTS USING THE SPLASH FONT DOWNLOADER UTILITY

1 Start the Splash Font Downloader utility from Mac Finder > Application > EFI Splash RPX-iii >
Utilities.

The first time you connect to the Splash Font Downloader utility, select the Splash Server
from the Splash Connection dialog box.

To change the Splash Server, select Splash Connection from the Splash Font Downloader
menu, and then select a Splash Server.

2 Click Add and browse to the font that you want to download.
3 Select the font and click Download.

You can add one or more fonts at a time.

Setting up scan mailboxes

Before you can set up mailboxes for scan jobs, make sure that all users have been added.
For information about setting up mailboxes, see the Job Management Guide.

Setting up Hot Folders and Virtual Printers

Hot Folders allow you to create multiple Drop folders, each with an assigned set of print
options that are applied to all jobs placed in the folder. This allows you to control print

options and process a series of jobs with common printer driver settings.

For any job placed in a Hot Folder, the options associated with the Hot Folder override any
options included in the job. A job created with the EFI Splash RPX-iii printer driver might

specify Duplex, Long Edge Bind, but if it is dropped into a folder for which Duplex is set to
None, the job will not print as Duplex.

You can also create Virtual Printers and assign options that override the options set at the
client.

For more information about Hot Folders and Virtual Printers, see the job Management Guide.
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Configuring the EFI Splash RPX-iii for Hot Folders

Hot Folders are created in the user’s Public:Hot Folders folder. Folders can be shared via
AppleTalk for Mac OS clients and via SMB for Windows clients. Hot Folders do not replace
existing Drop folders.

The Hot Folders feature is not supported for file types supported by the GA File Converter.
Any such files placed in a Hot Folder produce an error and are not printed.

To CONFIGURE THE EFI SPLASH RPX-iii FOR HOT FOLDERS

1
2

Log on to the EFI Splash RPX-iii with Administrator privileges.

Choose Hot Folders from the Server menu.

The Hot Folders dialog box appears.

Click the lock to unlock options and log on with Administrator privileges, if necessary.
Click the plus sign “+” and configure printer driver options for the Hot Folder.

Click OK.

Type a name for the Hot Folder.

This name is the name that the client selects at the client workstation.

Close the Hot Folders dialog box.

Editing Hot Folders

To edit the job options for a previously created Hot Folder, choose Hot Folders from the
Server menu. Click the lock to unlock options and log in as an administrator, if necessary.
Click the plus icon “+”and double-click the Hot Folder that you want to edit from the list of
Hot Folders and specify your changes. The Job Options dialog box appears, allowing you to
change the options.

If the options for a Hot Folder are being edited, the exact set of options that is applied is
dependent on when the job finishes copying to the Hot Folder and when the editing is
completed. For reliable results, complete the editing of Hot Folder options before submitting
jobs to the Hot Folder.

NOTE: As part of the removal process of the EFI Splash RPX-iii server software, Hot Folders
are deleted.

For more information about configuring the EFI Splash RPX-iii for file sharing, see Getting
Started.

Renaming Hot Folders

The maximum number of characters in the Rename field is 255. If you have not created any
Hot Folders, the Rename option is unavailable.
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Configuring Hot Folders for SMB file sharing

You can allow a user on a Windows client workstation to view a Mac OS system. Use the
following procedure to configure the EFI Splash RPX-iii for SMB file sharing from Windows
client workstations.

To CONFIGURE THE EFI SPLASH RPX-iii FOR FILE SHARING (MAc 0S 10.4)

1 Open System Preferences from the Apple menu.
2 Select Sharing.

3 Click the Services tab.

4 Select the Windows Sharing option.

5

Log on from a Windows computer.

To CONFIGURE THE EFI SPLASH RPX-iii FOR FILE SHARING (Mac 0S 10.5)

1 Open System Preferences from the Apple menu.

Select Sharing.

Select File Sharing and click Options.

Select “Share files and folders using SMB".

Select the name of the user account that will share files and type the password for that user.

Click Done.

N o v~ WD

Log on from a Windows computer.

Configuring Hot Folders for AppleTalk file sharing
Use the following procedure to configure the EFI Splash RPX-iii for AppleTalk file sharing.

To CONFIGURE THE EFT SPLASH RPX-iii FOR APPLETALK FILE SHARING (MAc 0S 10.4)

1 Choose System Preferences from the Apple menu.
2 Select Sharing.

3 Click the Services tab.

4 Select the Personal File Sharing option.

5

Log on from a Mac 0S X computer as guest.
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To CONFIGURE THE EFI SPLASH RPX-iii FOR APPLETALK FILE SHARING (MAc 0S 10.5)

1
2
3
4

Choose System Preferences from the Apple menu.
Select Sharing.
Select “Share files and folders using AFP".

Log on from a Mac 0S X computer as guest.

Configuring the EFI Splash RPX-iii for Virtual Printers

The administrator can create additional printers on the network as individual AppleTalk and
LPR print queues. Virtual printers are accessible via AppleTalk for Mac OS clients and via
LPR for Windows clients. The virtual printers apply chosen options to all jobs while allowing
other options to be selected in the printer driver.

A print job sent to a virtual printer will have the corresponding virtual printer job options
applied to it. A default print queue, “_Splash”, (which applies the server's default job options)
is also present.

To CONFIGURE THE EFI SPLASH RPX-iii FOR VIRTUAL PRINTERS

1
2

Log on to the EFI Splash RPX-iii with Administrator privileges.
Choose Virtual Printers from the Server menu.
The Virtual Printers dialog box appears.

To add a virtual printer, click the plus sign “+” and type the virtual printer name in the
Name field.

Publish the virtual printer on AppleTalk only, LPR only, or both.

Note: If AppleTalk or LPR is disabled in Server Preferences, the option is disabled for

virtual printers.
To remove a virtual printer, select the virtual printer name and click the minus sign “-".
To set virtual printer options, click Edit Options.

The Default Job Settings dialog box appears, allowing you to configure printer driver options
for the virtual printer.

Click OK.

For more information about setting options for virtual printers, see the Job Management
Guide.
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Scanning for viruses

The EFI Splash RPX-iii is compatible with Norton AntiVirus 10.0 for Mac OS X and
McAfee Virex 7.7 for Mac OS X. You must disable the Auto Scan feature for these
applications, or problems may occur. For example, spool files may become corrupted and
server preference changes may not be retained.

Energy considerations

Power-0On

The EFI Splash RPX-iii can be started before or after the digital press is powered on. No
power cycle of the digital press is required after the EFI Splash RPX-iii reboots. No power
cycle of the EFI Splash RPX-iii is required if the digital press power is cycled.

Energy Saver

When the digital press is in Energy Save mode, you can start and use the EFI Splash RPX-iii.
No power cycle of the digital press is required, even if the EFI Splash RPX-iii has been
rebooted.

EnergyStar Compliance

The Mac OS X computer is EnergyStar compliant. However, the EFI Splash RPX-iii as
configured at the factory is not compliant. If the EFI Splash RPX-iii is configured for
EnergyStar compliance, it can go into Sleep Mode and must be woken up before users can
print to it.

Sleep Mode

When the digital press is in Sleep Mode, you can start and use the EFI Splash RPX-iii. No
power cycle of the digital press is required, even if the EFI Splash RPX-iii has been rebooted.
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